
​YOUBOX STUDY​

​MICROSOFT EXCEL (MS-EXCEL)​

​Microsoft​ ​Excel​ ​(MS-Excel)​ ​is​ ​a​ ​Spreadsheet​ ​Software​ ​developed​ ​by​ ​Microsoft​ ​that​ ​is​ ​used​ ​for​
​storing, organizing, calculating, analyzing, and presenting data in tabular form.​

​A​​spreadsheet​​consists​​of​​rows​​and​​columns​​arranged​​in​​a​​grid​​format.​​The​​intersection​​of​​a​​row​​and​
​column is called a​​Cell​​.​

​MS-Excel​ ​is​ ​widely​ ​used​ ​in​ ​offices,​ ​businesses,​ ​schools,​ ​banks,​ ​and​ ​organizations​ ​for​​calculations,​
​budgeting, accounting, data analysis, and reporting.​

​Example​

​Preparing a monthly salary sheet in Excel.​

​Exam Tip​

​MS-Excel = Spreadsheet Software​

​WHAT IS A SPREADSHEET?​

​A​ ​Spreadsheet​ ​is​ ​an​ ​electronic​ ​worksheet​
​consisting​ ​of​ ​rows​ ​and​ ​columns​ ​used​ ​for​
​storing and processing data.​

​It​ ​performs​ ​calculations​ ​automatically​ ​using​
​formulas and functions.​

​Example​

​Student marksheets prepared in Excel.​

​Exam Tip​

​Spreadsheet​ ​=​ ​Rows​ ​+​ ​Columns​ ​+​
​Calculations​

​USES OF MS-EXCEL​

​MS-Excel is used for:​

​●​ ​Accounting​
​●​ ​Budgeting​
​●​ ​Billing​
​●​ ​Data Analysis​
​●​ ​Statistical Calculations​
​●​ ​Inventory Management​
​●​ ​Report Preparation​
​●​ ​Chart Creation​

​Example​

​Calculating annual sales of a company.​

​Exam Tip​

​Excel​ ​is​​mainly​​used​​for​​calculations​​and​​data​
​analysis.​

​OTHER SPREADSHEET SOFTWARE​

​Apart​​from​​MS-Excel,​​some​​other​​spreadsheet​
​software are:​

​●​ ​Corel Quattro Pro​
​●​ ​VisiCalc​
​●​ ​Lotus 1-2-3​
​●​ ​Apple Numbers​

​Example​

​Lotus​ ​1-2-3​ ​was​ ​one​ ​of​ ​the​ ​earliest​
​spreadsheet programs.​

​Exam Tip​

​VisiCalc​ ​=​ ​First​ ​Popular​ ​Spreadsheet​
​Software​

​STARTING MS-EXCEL​

​MS-Excel​ ​can​ ​be​ ​opened​ ​using​ ​different​
​methods.​

​METHOD 1​

​Using Run Command​

https://www.microsoft.com/?utm_source=chatgpt.com
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​Steps​

​1.​ ​Click Start Button.​
​2.​ ​Click Run.​
​3.​ ​Type​​excel​
​4.​ ​Press Enter.​

​Example​

​Opening Excel using the Run dialog box.​

​Exam Tip​

​Excel = Run Command for MS-ExceL​

​METHOD 2​

​Using Start Menu​

​Steps​

​1.​ ​Click Start Button.​
​2.​ ​Select All Programs.​
​3.​ ​Select Microsoft Office.​
​4.​ ​Click Microsoft Excel.​

​Example​

​Opening Excel through Start Menu.​

​Exam Tip​

​Most commonly used method.​

​DEFAULT EXCEL FILE​

​When​ ​Excel​ ​opens,​ ​a​ ​blank​ ​workbook​
​appears.​

​The default name is:​

​Book1​

​Example​

​Book1.xlsx​

​Exam Tip​

​Default Workbook Name = Book1​

​FILE EXTENSIONS OF EXCEL​

​Modern Excel File​

​.xlsx​

​Older Excel File​

​.xls​

​Example​

​Result.xlsx​

​Exam Tip​

​.xlsx = MS-Excel Workbook​

​COMPONENTS OF MICROSOFT EXCEL​

​TITLE BAR​

​The​ ​Title​ ​Bar​ ​appears​ ​at​ ​the​ ​top​ ​of​​the​​Excel​
​window.​

​It displays:​

​●​ ​Workbook Name​
​●​ ​Application Name​

​Example​

​Book1 - Microsoft Excel​

​Exam Tip​

​Title​ ​Bar​ ​=​ ​Workbook​ ​Name​ ​+​ ​Application​
​Name​

​CONTROL BUTTONS​

​Located on the Title Bar.​

​Minimize​

​Sends the window to the taskbar.​

​Maximize​

​Expands the window to full screen.​

​Close​

​Closes the Excel window.​

​Exam Tip​

​MMC = Minimize, Maximize, Close​
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​RIBBON​

​The​ ​Ribbon​ ​is​ ​the​ ​command​ ​area​ ​containing​
​tools and commands organized into tabs.​

​Example​

​Using the Home Tab to change font size.​

​Exam Tip​

​Ribbon = Collection of Tabs​

​TABS IN MS-EXCEL​

​MS-Excel contains several tabs on the Ribbon.​

​HOME TAB​

​The​ ​Home​ ​Tab​ ​contains​ ​commonly​ ​used​
​commands.​

​Groups Present​

​●​ ​Clipboard​
​●​ ​Font​
​●​ ​Alignment​
​●​ ​Number​
​●​ ​Styles​
​●​ ​Cells​
​●​ ​Editing​

​Example​

​Making text bold.​

​Exam Tip​

​Home​ ​Tab​ ​=​ ​Most​ ​Frequently​ ​Used​
​Commands​

​INSERT TAB​

​The​ ​Insert​ ​Tab​ ​is​​used​​to​​insert​​objects​​into​​a​
​worksheet.​

​Groups Present​

​●​ ​Tables​
​●​ ​Illustrations​
​●​ ​Charts​
​●​ ​Sparklines​
​●​ ​Filter​
​●​ ​Links​
​●​ ​Text​

​●​ ​Symbols​

​Example​

​Inserting a chart.​

​Exam Tip​

​Insert Tab = Add Objects​

​PAGE LAYOUT TAB​

​Controls​ ​worksheet​ ​appearance​ ​and​ ​printing​
​settings.​

​Groups Present​

​●​ ​Themes​
​●​ ​Page Setup​
​●​ ​Scale to Fit​
​●​ ​Sheet Options​
​●​ ​Arrange​

​Example​

​Changing page margins.​

​Exam Tip​

​Page Layout = Worksheet Design​

​FORMULAS TAB​

​Used for formulas and functions.​

​Groups Present​

​●​ ​Function Library​
​●​ ​Defined Names​
​●​ ​Formula Auditing​
​●​ ​Calculation​

​Example​

​Using the SUM function.​

​Exam Tip​

​Formulas Tab = Functions and Calculations​

​DATA TAB​

​Used for managing and analyzing data.​
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​Groups Present​

​●​ ​Get External Data​
​●​ ​Connections​
​●​ ​Sort & Filter​
​●​ ​Data Tools​
​●​ ​Outline​

​Example​

​Sorting student marks.​

​Exam Tip​

​Data Tab = Data Analysis Tools​

​REVIEW TAB​

​Used​ ​for​ ​proofreading​ ​and​ ​reviewing​
​worksheets.​

​Groups Present​

​●​ ​Proofing​
​●​ ​Language​
​●​ ​Comments​
​●​ ​Changes​

​Example​

​Adding comments to cells.​

​Exam Tip​

​Review Tab = Proofreading Tools​

​VIEW TAB​

​Controls worksheet display options.​

​Groups Present​

​●​ ​Workbook Views​
​●​ ​Show​
​●​ ​Zoom​
​●​ ​Window​
​●​ ​Macros​

​Example​

​Zooming into a worksheet.​

​Exam Tip​

​View Tab = Display Settings​

​STATUS BAR​

​The​ ​Status​ ​Bar​ ​appears​ ​at​ ​the​ ​bottom​ ​of​ ​the​
​Excel window.​

​It​ ​displays​ ​information​ ​about​ ​the​ ​active​
​worksheet.​

​Information Displayed​

​●​ ​Worksheet Status​
​●​ ​Page Number​
​●​ ​Zoom Level​
​●​ ​View Shortcuts​

​Example​

​Showing Zoom 100%.​

​Exam Tip​

​Status Bar = Worksheet Information Area​

​FORMULA BAR​

​The Formula Bar is located below the Ribbon.​

​It is used to:​

​●​ ​Enter Data​
​●​ ​Edit Data​
​●​ ​Enter Formulas​
​●​ ​View Formula Contents​

​Example​

​Typing =SUM(A1:A5)​

​Exam Tip​

​Formula Bar = Formula Entry Area​

​NAME BOX​

​The​ ​Name​ ​Box​ ​is​ ​located​ ​to​ ​the​ ​left​ ​of​ ​the​
​Formula Bar.​

​It displays the reference of the active cell.​

​Example​

​A1, B5, C10​

​Exam Tip​

​Name Box = Cell Address Display​
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​CELL​

​A​ ​Cell​ ​is​ ​the​ ​intersection​ ​of​ ​a​ ​row​ ​and​ ​a​
​column.​

​Each cell has a unique address.​

​Example​

​A1​

​●​ ​A = Column​
​●​ ​1 = Row​

​Exam Tip​

​Cell Address = Column + Row​

​FUNCTIONS IN MS-EXCEL​

​Functions​ ​are​ ​predefined​ ​formulas​ ​used​ ​to​
​perform calculations automatically.​

​Example​

​=SUM(A1:A5)​

​Exam Tip​

​Function = Predefined Formula​

​IMPORTANT FUNCTIONS OF MS-EXCEL​

​SUM FUNCTION​

​The SUM function adds values.​

​Syntax​

​=SUM(A1:A5)​

​Exampl​

​Adds all numbers from A1 to A5.​

​Exam Tip​

​SUM = Addition​

​AVERAGE FUNCTION​

​Calculates the average of values.​

​Syntax​

​=AVERAGE(A1:A5)​

​Example​

​Calculates average marks of students.​

​Exam Tip​

​AVERAGE = Mean Value​

​COUNT FUNCTION​

​Counts cells containing numeric values.​

​Syntax​

​=COUNT(A1:A5)​

​Example​

​Counts number of students with marks.​

​Exam Tip​

​COUNT = Count Numbers​

​MAX FUNCTION​

​Returns the largest value.​

​Syntax​

​=MAX(A1:A5)​

​Example​

​Finds highest marks.​

​Exam Tip​

​MAX = Highest Value​

​MIN FUNCTION​

​Returns the smallest value.​

​Syntax​
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​=MIN(A1:A5)​

​Example​

​Finds lowest marks.​

​Exam Tip​

​MIN = Lowest Value​

​FUNCTION TABLE​

​Function​ ​Purpose​ ​Example​

​SUM​ ​Adds​
​values​

​=SUM(A1:A5)​

​AVERAGE​ ​Calculates​
​average​

​=AVERAGE(A1​
​:A5)​

​COUNT​ ​Counts​
​numeric​

​cells​

​=COUNT(A1:A​
​5)​

​MAX​ ​Finds​
​largest​
​value​

​=MAX(A1:A5)​

​MIN​ ​Finds​
​smallest​

​value​

​=MIN(A1:A5)​

​MOST IMPORTANT EXAM FACTS​

​MS-Excel​

​Spreadsheet Software.​

​Default Workbook Name​

​Book1​

​Excel Extension​

​.xlsx​

​Formula Bar​

​Used to enter formulas.​

​Name Box​

​Displays active cell address.​

​Cell​

​Intersection of row and column.​

​SUM Function​

​Adds values.​

​MAX Function​

​Returns highest value.​

​MIN Function​

​Returns lowest value.​

​COUNT Function​

​Counts numeric cells.​

​QUICK REVISION TABLE​

​Topic​ ​Remember As​

​MS-Excel​ ​Spreadsheet Software​

​Workbook​ ​Excel File​

​Worksheet​ ​Spreadsheet Page​

​Cell​ ​Row + Column Intersection​

​Formula Bar​ ​Formula Entry Area​

​Name Box​ ​Cell Address​

​SUM​ ​Addition​

​AVERAGE​ ​Mean​

​COUNT​ ​Count Numbers​

​MAX​ ​Highest Value​

​MIN​ ​Lowest Value​

​BASIC TERMS OF SPREADSHEET​

​A​ ​Spreadsheet​ ​is​ ​an​ ​electronic​ ​worksheet​
​used​​to​​enter,​​calculate,​​organize,​​manipulate,​
​and​ ​analyze​ ​data​ ​in​ ​the​ ​form​ ​of​ ​rows​ ​and​
​columns.​
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​It​ ​is​ ​widely​ ​used​ ​for​ ​accounting,​ ​budgeting,​
​billing,​ ​statistical​ ​analysis,​ ​and​ ​record​
​management.​

​Example​

​Preparing a student marksheet in MS-Excel.​

​Exam Tip​

​Spreadsheet​ ​=​ ​Rows​ ​+​ ​Columns​ ​+​
​Calculations​

​CELL​

​A​ ​Cell​​is​​the​​intersection​​point​​of​​a​​row​​and​​a​
​column.​

​It​​is​​the​​basic​​unit​​of​​a​​worksheet​​where​​data​​is​
​entered.​

​A cell can contain:​

​●​ ​Numbers (Constants)​
​●​ ​Text (Labels)​
​●​ ​Formulas​

​Example​

​Cell A1​

​Exam Tip​

​Cell = Intersection of Row and Column​

​TYPES OF DATA IN A CELL​

​NUMBERS (CONSTANTS)​

​Numeric values entered into a cell.​

​Example​

​250, 5000, 98​

​Exam Tip​

​Numbers are used in calculations.​

​TEXT (LABELS)​

​Alphabetic or descriptive information.​

​Example​

​Name, Salary, Total Marks​

​Exam Tip​

​Labels describe data.​

​FORMULAS​

​Mathematical​ ​expressions​ ​used​ ​to​ ​perform​
​calculations.​

​Example​

​=SUM(A1:A5)​

​Exam Tip​

​Formula Always Begins with "="​

​WORKSHEET​

​A​ ​Worksheet​ ​is​ ​a​ ​collection​ ​of​ ​rows​ ​and​
​columns containing cells.​

​It is also called a​​Sheet​​.​

​A worksheet stores data in tabular form.​

​Example​

​A salary sheet containing employee details.​

​Exam Tip​

​Worksheet = Single Spreadsheet Page​

​WORKBOOK​

​A​​Workbook​​is​​an​​Excel​​file​​that​​contains​​one​
​or more worksheets.​

​Example​

​Book1.xlsx​

​Exam Tip​

​Workbook = Collection of Worksheets​

​IMPORTANT FACT​

​In​ ​traditional​ ​MS-Excel​ ​versions,​ ​a​ ​new​
​workbook contains​​3 worksheets by default​​.​
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​Example​

​Sheet1, Sheet2, Sheet3​

​Exam Tip​

​Default​ ​Worksheets​ ​=​ ​3​ ​(Traditional​
​Versions)​

​ROW​

​A​​Row​​is a horizontal arrangement of cells.​

​Rows are identified by numbers.​

​Row Numbering​

​1, 2, 3, 4, 5, …​

​Example​

​Row 10​

​Exam Tip​

​Rows = Horizontal = Numbers​

​COLUMN​

​A​​Column​​is a vertical arrangement of cells.​

​Columns are identified by letters.​

​Column Naming​

​A, B, C, D … Z, AA, AB, AC …​

​Example​

​Column C​

​Exam Tip​

​Columns = Vertical = Letters​

​ACTIVE CELL​

​The​​Active​​Cell​​is​​the​​currently​​selected​​cell​​in​
​which data can be entered or edited.​

​It is highlighted by a border.​

​Example​

​Cell B4 selected for entering marks.​

​Exam Tip​

​Active Cell = Currently Working Cell​

​CELL POINTER​

​A​ ​Cell​ ​Pointer​ ​is​ ​the​ ​highlighted​ ​boundary​
​around the active cell.​

​It​ ​indicates​ ​the​ ​current​ ​position​ ​in​ ​the​
​worksheet.​

​Example​

​Black border around Cell A1.​

​Exam Tip​

​Cell Pointer Identifies the Active Cell​

​FORMULA​

​A​ ​Formula​ ​is​ ​an​ ​equation​ ​used​ ​to​ ​calculate​
​values in a worksheet.​

​Every​ ​formula​ ​must​ ​begin​ ​with​​an​​Equal​​Sign​
​(=).​

​Example​

​= A1 + A2​

​Exam Tip​

​Formula Always Starts with "="​

​CELL ADDRESS​

​A​ ​Cell​ ​Address​​identifies​​the​​location​​of​​a​​cell​
​by​ ​combining​ ​its​ ​column​ ​letter​ ​and​ ​row​
​number.​

​Example​

​A1​

​Where:​

​●​ ​A = Column​
​●​ ​1 = Row​

​Other Examples​

​●​ ​B5​
​●​ ​C10​
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​●​ ​D25​

​Exam Tip​

​Cell​ ​Address​ ​=​ ​Column​ ​Letter​ ​+​ ​Row​
​Number​

​QUICK REVISION TABLE​

​Term​ ​Meaning​

​Cell​ ​Intersection of Row and​
​Column​

​Worksheet​ ​Single Spreadsheet Page​

​Workbook​ ​Collection of Worksheets​

​Row​ ​Horizontal Cells​

​Column​ ​Vertical Cells​

​Active Cell​ ​Currently Selected Cell​

​Cell Pointer​ ​Border Around Active Cell​

​Formula​ ​Mathematical Equation​

​Cell​
​Address​

​Location of Cell​

​CHARTS IN MS-EXCEL​

​A​ ​Chart​ ​is​ ​the​ ​graphical​ ​representation​ ​of​
​worksheet data.​

​Charts​ ​help​ ​users​ ​understand​ ​data​ ​quickly​
​through visual presentation.​

​Example​

​Displaying monthly sales using a chart.​

​Exam Tip​

​Chart = Graphical Representation of Data​

​TYPES OF CHARTS​

​AREA CHART​

​An​ ​Area​ ​Chart​ ​emphasizes​ ​the​ ​magnitude​ ​of​
​change over time.​

​The area below the line is filled with color.​

​Example​

​Showing annual profit growth.​

​Exam Tip​

​Area Chart = Magnitude of Change​

​COLUMN CHART​

​A​ ​Column​ ​Chart​ ​displays​ ​data​ ​using​ ​vertical​
​columns.​

​It​​is​​used​​to​​compare​​values​​or​​show​​changes​
​over time.​

​Example​

​Comparing marks of students.​

​Exam Tip​

​Column Chart = Vertical Bars​

​BAR CHART​

​A​ ​Bar​ ​Chart​ ​displays​ ​data​ ​using​ ​horizontal​
​bars.​

​Categories​ ​are​ ​shown​ ​vertically​ ​while​ ​values​
​are shown horizontally.​

​Example​

​Comparing sales of products.​

​Exam Tip​

​Bar Chart = Horizontal Bars​

​LINE CHART​

​A​ ​Line​ ​Chart​ ​shows​​trends​​and​​changes​​over​
​time.​

​Data points are connected by lines.​

​Example​

​Monthly temperature changes.​

​Exam Tip​
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​Line Chart = Trends Over Time​

​PIE CHART​

​A​ ​Pie​ ​Chart​ ​shows​ ​how​ ​individual​ ​values​
​contribute to a whole.​

​It is divided into slices.​

​Example​

​Market share of companies.​

​Exam Tip​

​Pie Chart = Parts of a Whole​

​XY (SCATTER) CHART​

​A​ ​Scatter​ ​Chart​ ​shows​ ​the​ ​relationship​
​between two numerical variables.​

​It plots data as XY coordinates.​

​Example​

​Relationship between study hours and marks.​

​Exam Tip​

​Scatter​ ​Chart​ ​=​ ​Relationship​ ​Between​
​Variables​

​CHART COMPARISON TABLE​

​Chart Type​ ​Best Used For​

​Area Chart​ ​Magnitude of Change​

​Column​
​Chart​

​Comparison Over Time​

​Bar Chart​ ​Comparing Categories​

​Line Chart​ ​Trends​

​Pie Chart​ ​Proportions​

​Scatter​
​Chart​

​Relationship Between​
​Variables​

​COMPONENTS OF A CHART​

​CHART AREA​

​The entire area occupied by the chart.​

​It includes all chart elements.​

​Example​

​Complete chart including title and legend.​

​Exam Tip​

​Chart Area = Entire Chart​

​PLOT AREA​

​The​ ​area​ ​where​ ​actual​ ​data​ ​is​ ​displayed​
​graphically.​

​Example​

​Bars,​ ​lines,​ ​and​ ​pie​ ​slices​ ​displayed​ ​in​ ​the​
​chart.​

​Exam Tip​

​Plot Area = Data Display Area​

​CHART TITLE​

​The heading of the chart.​

​It explains what the chart represents.​

​Example​

​"Monthly Sales Report"​

​Exam Tip​

​Chart Title = Name of Chart​

​AXIS TITLE​

​Titles given to chart axes.​

​Types​

​●​ ​X-Axis Title​
​●​ ​Y-Axis Title​
​●​ ​Z-Axis Title (3D Charts)​

​Example​

​X-Axis = Months​
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​Y-Axis = Sales​

​Exam Tip​

​Axis Titles Describe Axes​

​DATA SERIES​

​A row or column of values plotted in a chart.​

​Example​

​Monthly sales figures.​

​Exam Tip​

​Data Series = Data Used in Chart​

​GRIDLINES​

​Horizontal​ ​and​ ​vertical​ ​reference​ ​lines​ ​that​
​improve readability.​

​Example​

​Lines helping identify chart values.​

​Exam Tip​

​Gridlines Improve Chart Reading​

​LEGEND​

​A​ ​Legend​ ​identifies​ ​different​ ​data​ ​series​
​represented in the chart.​

​Example​

​Blue = Sales​

​Red = Profit​

​Exam Tip​

​Legend = Data Identifier​

​DATA LABEL​

​Displays​ ​exact​ ​values​ ​directly​ ​on​ ​chart​
​elements.​

​Example​

​Showing "500" above a column.​

​Exam Tip​

​Data Label = Actual Value Display​

​DATA TABLE​

​A​ ​Data​ ​Table​ ​displays​ ​chart​ ​data​ ​in​ ​tabular​
​form along with the chart.​

​Example​

​Monthly sales data displayed below a chart.​

​Exam Tip​

​Data Table = Chart Data in Table Format​

​IMPORTANT EXAM FACTS​

​Chart Wizard​

​Chart​ ​Wizard​ ​is​ ​used​ ​to​ ​create​ ​charts​ ​in​
​MS-Excel.​

​Example​

​Creating a Pie Chart using Chart Wizard.​

​Exam Tip​

​Chart Wizard = Chart Creation Tool​

​Embedded Chart​

​A chart created on an existing worksheet.​

​Example​

​Sales chart placed within the worksheet.​

​Exam Tip​

​Embedded​ ​Chart​ ​=​ ​Chart​ ​on​ ​Same​
​Worksheet​

​$ Sign in Excel​

​The​ ​Dollar​​Sign​​($)​​locks​​a​​cell​​reference​​to​​a​
​fixed position.​

​Example​

​$A$1​

​Exam Tip​
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​$ = Absolute Cell Reference​

​Stacked Bar/Column Chart​

​Shows​ ​the​ ​relationship​ ​of​ ​individual​ ​items​ ​to​
​the whole.​

​Example​

​Department-wise contribution to total sales.​

​Exam Tip​

​Stacked Chart = Part-to-Whole Relationship​

​MOST IMPORTANT EXAM QUESTIONS​

​Question​ ​Answer​

​Intersection of Row and​
​Column?​

​Cell​

​Collection of Worksheets?​ ​Workbook​

​Horizontal Arrangement?​ ​Row​

​Vertical Arrangement?​ ​Column​

​Formula Begins With?​ ​=​

​Graphical Representation of​
​Data?​

​Chart​

​Pie Chart Shows?​ ​Proportion​

​Trend Over Time?​ ​Line Chart​

​Relationship Between​
​Variables?​

​Scatter​
​Chart​

​Chart Creation Tool?​ ​Chart​
​Wizard​

​Locks Cell Reference?​ ​$ Sign​

​ADVANCED MICROSOFT EXCEL​

​The​ ​following​ ​topics​ ​cover​ ​advanced​ ​Excel​
​functions,​ ​Data​ ​Tab​ ​tools,​ ​Review​ ​Tab​
​features,​ ​cell​ ​references,​ ​Excel​ ​errors,​ ​and​
​chart​​concepts​​frequently​​asked​​in​​competitive​
​examinations.​

​DATE AND TIME FUNCTIONS​

​Date​ ​and​ ​Time​ ​Functions​ ​are​ ​used​ ​to​ ​work​
​with​ ​dates,​ ​months,​ ​years,​ ​days,​ ​and​ ​time​
​values in Excel.​

​TODAY()​

​Returns the current system date.​

​Syntax​

​=TODAY()​

​Example​

​If today's date is 11-06-2026​

​=TODAY()​

​Result: 11-06-2026​

​Exam Tip​

​TODAY() returns only the current date.​

​NOW()​

​Returns the current date and current time.​

​Syntax​

​=NOW()​

​Example​

​Result: 11-06-2026 10:30 AM​

​Exam Tip​

​NOW() returns both date and time.​

​DATE()​

​Returns​ ​a​ ​valid​ ​date​ ​from​ ​year,​ ​month,​ ​and​
​day values.​

​Example​

​=DATE(2026,6,11)​



​YOUBOX STUDY​

​Result: 11-Jun-2026​

​Exam Tip​

​DATE() creates a date value.​

​DAY()​

​Returns the day number from a date.​

​Example​

​=DAY("11-Jun-2026")​

​Result: 11​

​Exam Tip​

​DAY() extracts day value.​

​MONTH()​

​Returns the month number from a date.​

​Example​

​=MONTH("11-Jun-2026")​

​Result: 6​

​Exam Tip​

​MONTH() extracts month value.​

​YEAR()​

​Returns the year from a date.​

​Example​

​=YEAR("11-Jun-2026")​

​Result: 2026​

​Exam Tip​

​YEAR() extracts year value.​

​TIME()​

​Creates​​a​​time​​value​​from​​hours,​​minutes,​​and​
​seconds.​

​Example​

​=TIME(10,30,0)​

​Result: 10:30 AM​

​Exam Tip​

​TIME() creates time values.​

​TEXT FUNCTIONS​

​Text​ ​Functions​ ​manipulate​ ​text​ ​strings​ ​in​
​Excel.​

​LEN()​

​Returns total number of characters.​

​Example​

​=LEN("Computer")​

​Result: 8​

​Exam Tip​

​LEN() counts characters including spaces.​

​UPPER()​

​Converts text into uppercase.​

​Example​

​=UPPER("Clean Me")​

​Result: CLEAN ME​

​Exam Tip​

​UPPER() → Capital Letters.​

​LOWER()​

​Converts text into lowercase.​

​Example​

​=LOWER("COMPUTER")​
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​Result: computer​

​Exam Tip​

​LOWER() → Small Letters.​

​PROPER()​

​Converts first letter of every word into capital.​

​Example​

​=PROPER("shyam kumar")​

​Result: Shyam Kumar​

​Exam Tip​

​PROPER() → Title Case.​

​CONCATENATE()​

​Combines multiple text strings.​

​Example​

​=CONCATENATE("Hello"," ","World")​

​Result: Hello World​

​Exam Tip​

​CONCATENATE() joins strings.​

​TRIM()​

​Removes extra spaces.​

​Example​

​=TRIM(" Hello World ")​

​Result: Hello World​

​Exam Tip​

​TRIM() removes unnecessary spaces.​

​LEFT()​

​Returns characters from left side.​

​Example​

​=LEFT("RAJASTHAN",3)​

​Result: RAJ​

​Exam Tip​

​LEFT() extracts left characters.​

​RIGHT()​

​Returns characters from right side.​

​Example​

​=RIGHT("India",2)​

​Result: ia​

​Exam Tip​

​RIGHT() extracts right characters.​

​MID()​

​Returns middle characters.​

​Example​

​=MID("GANGA",2,2)​

​Result: AN​

​Exam Tip​

​MID() extracts characters from middle position.​

​CHAR()​

​Returns​ ​character​ ​corresponding​ ​to​ ​ASCII​
​code.​

​Example​

​=CHAR(65)​

​Result: A​

​Exam Tip​

​CHAR() converts ASCII Number to Character.​
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​CODE()​

​Returns ASCII code of a character.​

​Example​

​=CODE("A")​

​Result: 65​

​Exam Tip​

​CODE() converts Character to ASCII Number.​

​LOGICAL FUNCTIONS​

​Logical​ ​Functions​ ​return​ ​TRUE​ ​or​ ​FALSE​
​based on conditions.​

​IF()​

​Returns​ ​one​ ​value​ ​if​ ​condition​ ​is​ ​true​ ​and​
​another if false.​

​Example​

​=IF(120>100,"Hello","Neon")​

​Result: Hello​

​Exam Tip​

​IF() = Condition Testing Function.​

​AND()​

​Returns TRUE if all conditions are true.​

​Example​

​=AND(20<25,11>10)​

​Result: TRUE​

​Exam Tip​

​AND() = All Conditions True.​

​OR()​

​Returns TRUE if any condition is true.​

​Example​

​=OR(5>6,15=15)​

​Result: TRUE​

​Exam Tip​

​OR() = Any One Condition True.​

​NOT()​

​Reverses logical result.​

​Example​

​=NOT(10>6)​

​Result: FALSE​

​Exam Tip​

​NOT() reverses TRUE and FALSE.​

​IFERROR()​

​Replaces an error with a specified value.​

​Example​

​=IFERROR(A1/B1,"Error")​

​Exam Tip​

​IFERROR() handles errors gracefully.​

​COUNTING FUNCTIONS​

​COUNT()​

​Counts cells containing numbers.​

​=COUNT(A1:A10)​

​Exam Tip​

​COUNT() counts numeric cells only.​

​COUNTA()​

​Counts cells containing any data.​
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​=COUNTA(A1:A10)​

​Exam Tip​

​COUNTA() counts non-empty cells.​

​COUNTIF()​

​Counts cells matching a condition.​

​=COUNTIF(A1:A10,">50")​

​Exam Tip​

​COUNTIF() = Single Condition Counting.​

​COUNTIFS()​

​Counts cells matching multiple conditions.​

​Exam Tip​

​COUNTIFS() = Multiple Conditions Counting.​

​SUMMATION FUNCTIONS​

​SUMIF()​

​Adds values according to one condition.​

​Example​

​=SUMIF(A1:A10,">50")​

​Exam Tip​

​SUMIF() = Single Condition Addition.​

​SUMIFS()​

​Adds values according to multiple conditions.​

​Exam Tip​

​SUMIFS() = Multiple Conditions Addition.​

​OTHER IMPORTANT FUNCTIONS​

​Function​ ​Purpose​

​ABS()​ ​Converts negative value​
​into positive value​

​EXACT()​ ​Compares two text strings​

​REP()​ ​Repeats text​

​CEILING()​ ​Rounds up to nearest​
​multiple​

​FLOOR()​ ​Rounds down to nearest​
​multiple​

​CLEAN()​ ​Removes non-printable​
​characters​

​DOLLAR()​ ​Converts number into​
​currency format​

​LOOKUP()​ ​Searches a value​

​VLOOKUP()​ ​Vertical lookup​

​HLOOKUP()​ ​Horizontal lookup​

​QUARTILE()​ ​Returns quartile values​

​ACCRINTM()​ ​Returns accrued interest​
​at maturity​

​CELL REFERENCES​

​Cell​ ​Reference​ ​identifies​ ​a​ ​cell​ ​location​ ​using​
​row and column coordinates.​

​RELATIVE CELL REFERENCE​

​Changes automatically when copied.​

​Example​

​=A1+B1​

​Exam Tip​

​Relative​ ​Reference​ ​is​ ​the​ ​default​ ​reference​
​type.​

​ABSOLUTE CELL REFERENCE​

​Does not change when copied.​

​Example​
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​=$A$1​

​Exam Tip​

​Dollar ($) sign locks row and column.​

​MIXED CELL REFERENCE​

​Locks either row or column.​

​Examples​

​=A$1​

​=$A1​

​Exam Tip​

​Mixed Reference = Partial Locking.​

​F4 KEY​

​Used​ ​to​ ​switch​ ​between​ ​Relative,​ ​Absolute,​
​and Mixed references.​

​Exam Tip​

​F4 = Change Cell Reference Type​

​EXCEL ERRORS​

​Error​ ​Meaning​

​#REF!​ ​Invalid Cell Reference​

​#VALUE!​ ​Wrong Data Type​

​#NAME?​ ​Misspelled Function Name​

​#NULL?​ ​Incorrect Cell Reference​

​###​ ​Column Width Too Small​

​#DIV/0!​ ​Division by Zero​

​#NUM!​ ​Invalid Numeric Value​

​Exam Tip​

​#DIV/0!​ ​occurs​ ​when​ ​dividing​ ​by​ ​zero​ ​or​
​blank cell.​

​DATA TAB​

​The Data Tab contains:​

​●​ ​Sort​
​●​ ​Filter​
​●​ ​Data Tools​
​●​ ​Connections​
​●​ ​Get External Data​

​Exam Tip​

​Data Tab = Data Management Tools.​

​REVIEW TAB​

​Contains:​

​●​ ​Proofing​
​●​ ​Language​
​●​ ​Translate​
​●​ ​Comments​
​●​ ​Compare​
​●​ ​Protect​

​Exam Tip​

​F7 = Spelling and Grammar Check.​

​VIEW TAB​

​Contains:​

​●​ ​Workbook Views​
​●​ ​Zoom​
​●​ ​Window​
​●​ ​Freeze Panes​
​●​ ​Macros​

​Important Facts​

​●​ ​Minimum Zoom = 10%​
​●​ ​Maximum Zoom = 400%​
​●​ ​Freeze Panes keeps headings visible​

​while scrolling.​

​Exam Tip​

​Freeze​ ​Top​​Row​​keeps​​first​​row​​visible​​during​
​scrolling.​

​CHARTS​

​A​ ​Chart​ ​is​ ​a​ ​graphical​ ​representation​ ​of​
​worksheet​​data​​using​​bars,​​lines,​​columns,​​pie​
​slices, and other visual formats.​
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​Exam Tip​

​Chart Wizard is used to create charts in Excel.​

​FORMULAS TAB IN MS-EXCEL​

​The​​Formulas Tab​​contains tools used for​
​creating, managing, auditing, and calculating​
​formulas in Excel.​

​It provides access to functions, named ranges,​
​formula auditing tools, and calculation options.​

​Main Groups in Formulas Tab​

​●​ ​Function Library​
​●​ ​Defined Names​
​●​ ​Formula Auditing​
​●​ ​Calculation​

​Example​

​Using the SUM function to calculate total​
​marks.​

​Exam Tip​

​Formulas Tab = Functions + Calculations +​
​Formula Auditing​

​FORMULA OPERATORS IN EXCEL​

​Operators are symbols used in formulas to​
​perform calculations and comparisons.​

​ARITHMETIC OPERATORS​

​Used for mathematical calculations.​

​Operator​ ​Meaning​ ​Example​

​+​ ​Addition​ ​=5+3​

​-​ ​Subtraction​ ​=10-2​

​*​ ​Multiplication​ ​=5*4​

​/​ ​Division​ ​=20/5​

​%​ ​Percentage​ ​=50%​

​̂ ​ ​Power​ ​=2^3​

​Example​
​=10+20​

​Result = 30​

​Exam Tip​

​Arithmetic Operators perform calculations.​

​COMPARISON OPERATORS​

​Used to compare two values.​

​Operator​ ​Meaning​

​=​ ​Equal To​

​>​ ​Greater Than​

​<​ ​Less Than​

​>=​ ​Greater Than or Equal To​

​<=​ ​Less Than or Equal To​

​<>​ ​Not Equal To​

​Example​
​=10>5​

​Result = TRUE​

​Exam Tip​

​Comparison Operators return TRUE or​
​FALSE.​

​TEXT OPERATOR​

​Used to join text strings.​

​Symbol​

​&​

​Example​
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​="Hello"&" World"​

​Result = Hello World​

​Exam Tip​

​& = Text Concatenation Operator​

​REFERENCE OPERATOR​

​Used to define cell references and ranges.​

​Example​
​=A1:B10​

​Exam Tip​

​Reference Operators specify cell ranges.​

​LOGICAL OPERATOR​

​Used in logical calculations.​

​Example​
​=AND(A1>10,B1<20)​

​Exam Tip​

​Logical Operators return TRUE or FALSE.​

​DOLLAR ($) SYMBOL​

​Used to create an Absolute Cell Reference.​

​Example​
​=$A$1​

​Exam Tip​

​$ Symbol = Absolute Reference​

​FUNCTION​

​A Function is a predefined formula in Excel​
​used to perform calculations automatically.​

​Example​
​=SUM(A1:A5)​

​Exam Tip​

​Function = Predefined Formula​

​STEPS TO CREATE A FORMULA​

​Step 1​

​Select the cell.​

​Step 2​

​Type Equal Sign (=).​

​Step 3​

​Enter Function Name.​

​Step 4​

​Specify Cell Range.​

​Example​
​=SUM(B1:B8)​

​Exam Tip​

​Every formula begins with "=" sign.​

​NUMERIC ENTRIES​

​Numbers and formulas entered into a cell are​
​called Numeric Entries.​

​Example​

​250​

​=SUM(A1:A5)​

​Exam Tip​

​Numeric Entries = Numbers + Formulas​
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​IMPORTANT ARITHMETIC FUNCTIONS​

​SUM()​

​Adds numbers.​

​Syntax​
​=SUM(A1:A5)​

​Example​

​A1=10, A2=20, A3=30​

​Result = 60​

​Exam Tip​

​SUM() = Addition Function​

​Important Fact​

​Typing only:​

​=SUM​

​without arguments results in​​#NAME? Error​​.​

​PRODUCT()​

​Multiplies numbers.​

​Syntax​
​=PRODUCT(A1:A5)​

​Example​

​2 × 3 × 4 = 24​

​Exam Tip​

​PRODUCT() = Multiplication Function​

​MAX()​

​Returns largest value.​

​Example​

​=MAX(10,20,30,40,50)​

​Result = 50​

​Exam Tip​

​MAX() = Highest Value​

​MIN()​

​Returns smallest value.​

​Example​
​=MIN(10,20,30,40,50)​

​Result = 10​

​Exam Tip​

​MIN() = Lowest Value​

​AVERAGE()​

​Returns arithmetic mean.​

​Example​
​=AVERAGE(0,10,20)​

​Result = 10​

​Exam Tip​

​AVERAGE() = Mean Value​

​AVERAGEA()​

​Calculates average including numbers, text,​
​and logical values.​

​Example​

​Mixed data averaging.​

​Exam Tip​

​AVERAGEA() includes text and logical values.​



​YOUBOX STUDY​

​AVERAGEIF()​

​Calculates average based on a condition.​

​Example​
​=AVERAGEIF(A1:A10,">50")​

​Exam Tip​

​AVERAGEIF() = Single Condition Average​

​AVERAGEIFS()​

​Calculates average using multiple conditions.​

​Example​

​Average marks of Science students scoring​
​above 50.​

​Exam Tip​

​AVERAGEIFS() = Multiple Conditions Average​

​SUB()​

​Used to find difference between numbers.​

​Example​
​=SUB(A1,B1)​

​Exam Tip​

​SUB = Subtraction​

​ROUND()​

​Rounds a number to specified decimal places.​

​Example​
​=ROUND(1.666666667,2)​

​Result = 1.67​

​Exam Tip​

​ROUND() = Normal Rounding​

​ROUNDDOWN()​

​Rounds downward.​

​Example​
​=ROUNDDOWN(8.192578,2)​

​Result = 8.19​

​Exam Tip​

​ROUNDDOWN() = Always Lower​

​MOD()​

​Returns remainder after division.​

​Example​
​=MOD(5,2)​

​Result = 1​

​Exam Tip​

​MOD() = Remainder Function​

​COUNT()​

​Counts cells containing numbers.​

​Example​
​=COUNT(A,1,2,3,4)​

​Result = 4​

​Exam Tip​

​COUNT() Counts Numeric Values Only​

​ODD()​

​Rounds positive number to next odd integer.​

​Example​
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​=ODD(8)​

​Result = 9​

​Exam Tip​

​ODD() Returns Odd Number​

​EVEN()​

​Rounds number to nearest even integer.​

​Example​
​=EVEN(7)​

​Result = 8​

​Exam Tip​

​EVEN() Returns Even Number​

​ACCINT()​

​Returns accrued interest.​

​Example​

​Used in financial calculations.​

​Exam Tip​

​ACCINT() = Accrued Interest Function​

​INT()​

​Returns integer part of a number.​

​Example​
​=INT(12.75)​

​Result = 12​

​Exam Tip​

​INT() Removes Decimal Part​

​SIGN()​

​Returns sign of a number.​

​Number​ ​Result​

​Positive​ ​1​

​Negative​ ​-1​

​Zero​ ​0​

​Example​
​=SIGN(-15)​

​Result = -1​

​Exam Tip​

​SIGN() Identifies Number Sign​

​FIND()​

​Returns starting position of text.​

​Example​
​=FIND("ag","Kushagra")​

​Result = 5​

​Exam Tip​

​FIND() = Case Sensitive​

​SEARCH()​

​Returns position of text.​

​Example​
​=SEARCH("AG","Kushagra")​

​Result = 5​

​Exam Tip​

​SEARCH() = Not Case Sensitive​
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​REPLACE()​

​Replaces part of a string.​

​Example​
​=REPLACE("Computer",1,3,"Lap")​

​Exam Tip​

​REPLACE() Modifies Text​

​SUBSTITUTE()​

​Replaces existing text with new text.​

​Example​
​=SUBSTITUTE("India","India","Bharat")​

​Exam Tip​

​SUBSTITUTE() Replaces Text​

​SUMSQ()​

​Returns sum of squares.​

​Example​
​=SUMSQ(2,3)​

​Result = 13​

​Exam Tip​

​SUMSQ() = Sum of Squares​

​SUMPRODUCT()​

​Returns sum of products of corresponding​
​arrays.​

​Example​
​=SUMPRODUCT(A1:A3,B1:B3)​

​Exam Tip​

​SUMPRODUCT() = Multiply Then Add​

​TRUNC()​

​Removes decimal part.​

​Example​
​=TRUNC(15.987)​

​Result = 15​

​Exam Tip​

​TRUNC() = Truncate Decimal​

​POWER()​

​Raises a number to a power.​

​Example​
​=POWER(2,10)​

​Result = 1024​

​Exam Tip​

​POWER() = Exponent Function​

​SQRT()​

​Returns square root.​

​Example​
​=SQRT(81)​

​Result = 9​

​Exam Tip​

​SQRT() = Square Root Function​

​PAD()​

​Adds padding characters.​

​Exam Tip​
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​PAD() Used for Text Padding​

​TRANSPOSE()​

​Converts rows into columns and columns into​
​rows.​

​Example​

​Row Data → Column Data​

​Exam Tip​

​TRANSPOSE() = Row ↔ Column​

​LOG()​

​Returns logarithm of a number.​

​Example​
​=LOG(100,10)​

​Result = 2​

​Exam Tip​

​LOG() = Logarithmic Function​

​FACT()​

​Returns factorial value.​

​Example​
​=FACT(5)​

​Result = 120​

​Exam Tip​

​FACT() = Factorial Function​

​MATCH()​

​Searches a value and returns its relative​
​position.​

​Syntax​

​=MATCH(Lookup_Value,Lookup_Array,Match_​
​Type)​

​Example​
​=MATCH(50,A1:A10,0)​

​Exam Tip​

​MATCH() Returns Position, Not Value.​

​INDEX()​

​Returns value at intersection of row and​
​column.​

​Example​
​=INDEX(A1:C5,2,3)​

​Exam Tip​

​INDEX() Returns Cell Value from Position.​

​QUICK REVISION TABLE​

​Function​ ​Purpose​

​SUM​ ​Addition​

​PRODUCT​ ​Multiplication​

​MAX​ ​Highest Value​

​MIN​ ​Lowest Value​

​AVERAGE​ ​Mean​

​ROUND​ ​Round Off​

​MOD​ ​Remainder​

​COUNT​ ​Count Numbers​

​INT​ ​Integer Part​

​SIGN​ ​Sign of Number​

​FIND​ ​Case Sensitive Search​
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​SEARCH​ ​Case Insensitive Search​

​POWER​ ​Exponent​

​SQRT​ ​Square Root​

​FACT​ ​Factorial​

​MATCH​ ​Position Lookup​

​INDEX​ ​Value Lookup​

​TRANSPOSE​ ​Row ↔ Column​


